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Introduction 

Here’s what we’ll cover in this eBook 

• Why to even consider M365 as a Learning & Development (L&D) platform 

• How to create a scored quiz with Microsoft Forms and integrate it as a 

knowledge check in Stream videos 

• How to add Stream videos to modern SharePoint Online pages and Microsoft 

Teams 

• How to create and why to incorporate Yammer Communities 

• How to customize a SharePoint form with Power Apps 

• How to automate a training request with Power Automate, customizing a pre-

built template 

• How to deploy and customize the Microsoft Learning Pathways solution 

• Putting it all together as a L&D Portal based on a SharePoint Online 

Communications site template 

• Best practices for incorporating L&D into Microsoft Teams 

Side note 

I am going to preface this by stating I am a M365 Solutions Consultant, not a developer. 

For the automation here, consider it entry-level design. As you look at my solutions, you 

may see better ways, and if you’d like to share those ideas with me, I'm all ears. 

Fortunately for all of us, there are many quite talented Power Platform developers in the 

Collab365 community. This book is designed to help you maximize your M365 

investment by incorporating L&D. 

Check the appendix for links to articles that dive deeper into these apps and their 

features. 
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Microsoft 365 vs traditional LMS Systems 

 

Course Format & Compatibility & Integration with other Tools 

Learning Management Systems have come a long way in the types of content that can 

be implemented, but most still limit to a small number of acceptable data formats. 

With Microsoft 365, the content can be almost anything: 

• Text, images, and links on web pages 

• Videos with transcription and embedded, scored quizzes 

• Surveys & polls 

• Office files and templates 

• PDFs 

• Training calendars 

• Approval workflows for requests, documents and more 

• Conversations and announcements 

• Task assignment and tracking  
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And you are not just limited to pure training materials, integrate: 

• Annual goals 

• Performance reviews 

• Peer feedback 

• New hire orientation 

Security & Licensing 

Everything discussed in this book is available with an M365 E3 license, no additional 

licenses required, even for the forms and flows. That means one identity and license for 

your Help Desk to manage. And one identity to add to M365 Groups to grant access to 

their learning content, whether it be set of pages, folders, videos, or tasks. 

Time to Implement and Update 

Editing in modern SharePoint Online is quick and intuitive, with flexible page layouts 

and drag and drop capabilities. Every time a page is published, an option to add the 

page to navigation is presented. And with page versioning on by default and a 2-stage 

recycle bin, mistakes are easily remedied. 

While you will still want to consider design, user flow, and navigation, you no longer 

need a trained SharePoint staffer to create sites and page layouts and navigation. 

Mobile 

By default, all SharePoint Online pages and Microsoft Forms are mobile ready with 

responsive design built in. Additionally, SharePoint, Teams, Stream, Yammer, and Office 

all have mobile apps to improve access and navigation. 

Additionally, the Stream app allows users to download videos to watch offline. 
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Branding 

Building your L&D Portal in your M365 tenant prevents you from having to add your 

brand to an external LMS. This gives users a seamless experience with look, feel, and 

navigation.     

Building Blocks 

Forms  

Introduction 

Forms is an integrated Microsoft 365 app that allows users to create surveys, polls, and 

quizzes that can be shared internally or externally. For this solution, we will create a 

scored quiz with Forms, and the two words, forms, and quiz, will be used 

interchangeably.  

Useful Features  

Sharing & Security 

Forms can be shared in a wide variety of methods: 

• Sharing link 

• QR code that can be scanned with any phone’s camera to load a form 

• iFrame embed code 

• Embedded into a PowerPoint slide 

• Embedded onto a SharePoint Online page, either to collect responses or display 

responses 

• Added as a tab Microsoft Teams in any of three formats:  

o Edit mode so the team can create together 

o To collect results 

o To display results 
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• Embedded into a Stream video feed 

Forms can be set so that only users in your organization can respond or anyone with the 

link. Forms are not discoverable via search, so even if the form is set to those within your 

organization, only those with the link can locate the Form. Additionally, Forms, even 

when internal to your organization, can be set to anonymous. 

Shuffle Questions 

Shuffle all questions each time a quiz taker opens the form with the option to lock 

some. 

Assign Points to each Question 

Assign more difficult and complex question more points than the simpler ones. 

Accessibility 

Forms have made improvements to their accessibility features. Learn more here: 

https://techcommunity.microsoft.com/t5/microsoft-forms-blog/microsoft-forms-is-

committed-to-inclusive-design-and-accessible/ba-p/257057 

Limitations 

An organization can only have 200 Forms. Older forms will need to have their results 

exported to Excel and then be deleted to avoid this limit. 

Branding here is limited to a hex color, background image, and images embedded into 

the form. Custom corporate fonts cannot currently be integrated. 

https://techcommunity.microsoft.com/t5/microsoft-forms-blog/microsoft-forms-is-committed-to-inclusive-design-and-accessible/ba-p/257057
https://techcommunity.microsoft.com/t5/microsoft-forms-blog/microsoft-forms-is-committed-to-inclusive-design-and-accessible/ba-p/257057
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Create a Quiz 

Note: There is no Save button; all changes are automatically saved. 

1. From office.com or the app launcher click on the Forms icon 

2. Click New Quiz, add a name (up to 90 characters) 

a. Optional: add an image and a description (up to 1,000 characters) 
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3. Click +Add new, select question type, and type in the question 

4. If a longer explanation is needed, click the 3 dots to lower right of question and 

choose Subtitle 

 

 

5. For choice questions, hover over the question and click the check mark to indicate 

correct answer(s) 
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6. Optional: add a message to the respondent when an answer is selected by hovering 

over the question and clicking on the message icon. 

 

7. For text questions, type in Correct answer(s) 

 

 



 

 

10 

 

 

8. Assign Points for question 

9. Indicate whether question is required  

10. Repeat to enter all questions and answers 

11. Adjust Settings by clicking the 3 dots in top right corner 

a. Leave toggle set to let respondents can see results right away 

b. Leave radio button selected to Only people in my organization can respond 

c. Uncheck box to only allow one response per person 

d. Check box to shuffle questions 

e. Customize the thank you message so quiz takers know they can take the quiz 

again 

f. Check the box to get email notification of each response 
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Share the Quiz 

As stated in the introduction, this quiz can be shared in a variety of ways. For this 

example, we are going to embed it as a knowledge check in a Stream video. Instructions 

are included in the next chapter. 

Stream 

Introduction 

Stream is your organization’s video streaming platform and is the Office 365 Video 

replacement. It has a compelling set of features, making impressive improvements over 

its predecessor.  

 

Features 

Sharing & Security 

Stream videos can be shared via various methods: 



 

 

13 

• Sharing link 

• Embed as iFrame 

• Embedded into a PowerPoint, Sway, and OneNote page 

• Embedded onto SharePoint Online pages a single video, an entire channel (set of 

videos) or all videos 

• Added as a tab in Microsoft Teams 

• Shared to Yammer from Stream 

While videos can be grouped into channels, viewing can be locked down to certain 

Office 365 Groups; once a Group has been created in Teams, Planner, Yammer, etc., it 

will be available in Stream to have videos permissioned to it. Groups can also be created 

directly from Stream. 
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Transcription 

All uploaded videos are automatically transcribed. And if you are the video owner, you 

can also edit the feed should spellings or punctuation need to be updated. 

 

Deep Search 

Search transcripts of videos to find the exact point in a video where a given word or 

phrase is mentioned, and then click it to go to that spot in the video. 

Interactivity 

Add knowledge checks at various points in the video timeline to ensure viewers 

understand the content. 
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Accessibility 

For those who use screen readers, Stream has accessibility support. Learn more here: 

https://support.office.com/en-us/article/accessibility-support-for-microsoft-stream-

8f6a57ec-74f8-4b5e-bc9f-3d9e3691a54f 

Limitations 

Videos in Stream are accessible to your organization only. To share externally, videos 

will need to be downloaded and uploaded to a shared location. 

Create a Channel & Add Videos 

Considerations 

• Will this Channel be available company-wide or just for a certain Group? 

• Should this Channel include all training videos, or should it be just for a certain 

technology, process, or role? 

Create the Channel 

1. From office.com or from the app launcher, click on the Stream icon 

2. Click + Create and Channel 

https://support.office.com/en-us/article/accessibility-support-for-microsoft-stream-8f6a57ec-74f8-4b5e-bc9f-3d9e3691a54f
https://support.office.com/en-us/article/accessibility-support-for-microsoft-stream-8f6a57ec-74f8-4b5e-bc9f-3d9e3691a54f
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3. Assign a channel Name and add Description 

4. For this example, set channel access to a Group or Companywide 
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5. Optional: add a channel image 

6. Click Create 

Add Videos to Channel 

Add Videos already uploaded to Stream 

1. In the top navigation, click on My content 

2. Click icon to add to a channel 

 

3. In the Share with drop-down, select Channels and start typing the name of 

channel 

 

4. Click Save 

Upload new videos 

Drag & drop video files or click select more files to upload. 
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Share a Channel 

The channel we just created is company-wide, so any user who has Stream enabled as 

part of their licensing (enabled by default) will be able to view these videos when they 

navigate to Stream. Rather than directing end-users to Stream, we will be embedding 

these videos on both SharePoint pages and in Teams. 

Yammer 

Introduction 

Yammer has long been a misunderstood application, often labelled as ‘just social for 

enterprise.’ Historically, it’s also been another place for end-users to have to navigate to, 

understandably lowering its rank in usefulness. Now that it can be easily embedded as 

an interactive feed into Teams and SharePoint, that story is changing. 

Yammer makes an excellent replacement for email distribution groups, creating a 

searchable knowledge base maintained by your end-users. 
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Useful Features 

Q&A: Mark Best Answer 

Rather than simply asking a question as a default Post, it can be added as a Question 

allowing the poster and the Yammer community admin to mark the best answer and 

saving time for others with the same question. 

 

Polls, Praise and Announcements 

Quickly add polls, praise and announcements to the feed 
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Live Events 

Organize and hold Live Events in Yammer. Link to learn more about this is in the 

Appendix.  

Sharing & Security 

• Yammer Communities can be embedded onto SharePoint Online pages 

• Add as a tab in Teams 

• Add Communities as an app in the left pane in Teams 

Yammer now uses the same identities as the rest of Microsoft 365; users will not have a 

separate photo or account for Yammer anymore. 

New Communities can be created to be internal only or allow external guests as well as 

be set to private or public.  

Accessibility 

Yammer includes features for users with low dexterity or low vision with keyboard 

shortcuts, a screen-reader, and more. Learn more here: https://support.office.com/en-

us/article/Accessibility-in-Yammer-e16df68d-83bc-41f7-9f11-

636f9e5424e7#:~:text=Accessibility%20in%20Yammer%201%20In,for%20customers%20

with%20disabilities. 

Create a Community in Yammer 

1. From office.com or the app launcher, click on the Yammer icon 

2. In the left navigation, click on Create a Community 

https://support.office.com/en-us/article/Accessibility-in-Yammer-e16df68d-83bc-41f7-9f11-636f9e5424e7#:~:text=Accessibility%20in%20Yammer%201%20In,for%20customers%20with%20disabilities.
https://support.office.com/en-us/article/Accessibility-in-Yammer-e16df68d-83bc-41f7-9f11-636f9e5424e7#:~:text=Accessibility%20in%20Yammer%201%20In,for%20customers%20with%20disabilities.
https://support.office.com/en-us/article/Accessibility-in-Yammer-e16df68d-83bc-41f7-9f11-636f9e5424e7#:~:text=Accessibility%20in%20Yammer%201%20In,for%20customers%20with%20disabilities.
https://support.office.com/en-us/article/Accessibility-in-Yammer-e16df68d-83bc-41f7-9f11-636f9e5424e7#:~:text=Accessibility%20in%20Yammer%201%20In,for%20customers%20with%20disabilities.
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3. Enter the Name of the Community 

4. Add Members. This can be handled one of three ways: 

a. Add members individually 

b. Creates a csv file with email addresses and upload 

c. Set the Community to Public and share the link via email so employees 

self-enroll 

5. Leave toggle set to Public Access 

6. Click Create 

Share the Champions Community 

Adding members in the previous steps essentially shared your new Yammer community, 

but in the ‘Putting it all Together’ portion, we’ll go over how to embed Yammer 

communities into SharePoint and Teams so that your users don’t need to navigate to a 

separate location. 
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Training Request Form 

Introduction 

For this chapter, we will create a simple Training Request with a SharePoint Online List, 

add a custom form on top of it with Power Apps, and then add an approval flow with 

Power Automate.  

Important: This Training Request should live on your official Learning & Development 

SharePoint site; if you already have a SharePoint Online Site created, use that. 

Otherwise, create a new Communications Site OR wait to use the SharePoint site that 

gets deployed with the M365 Learning Pathways (next chapter). 

 

SharePoint Online List 

Create the List 

1. From the landing page of your site, click +New and then List 
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2. Add a choice column titled ‘Type of Training’ with choices: 

a. Course 

b. Conference 

c. Exam 

d. Study Guide | Practice Test 

3. Add a Number column titled ‘Cost’ 

4. Add a Date column titled ‘Start Date’ 

5. Add a Date column titled ‘End Date’ 

6. Add a multiline text field titled ‘Any additional info’ 

7. Add a choice column titled ‘Training Request Status’ with choices: 

a. Submitted 

b. Approved 

c. Rejected 

d. Cancelled 

▪ Set the default to ‘Submitted’ 

Conditional Formatting 

 

Optional: Add conditional formatting for a quick view into request status. In the 

screenshot above, I’ve added red and green indicators for approved and rejected, and 

I’ve added it to the Title column. You can add it to different/more columns as makes 

sense. 
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To add: 

1. Select the drop-down for the column you’d like to apply the formatting to 

 

2. Select Column settings > Format this column 

3. Select Conditional formatting and +Add rule 

4. Set the rule to If Training Request Status is equal to Approved and click the Sample 

text box to select a green shade 

 

5. Click Save 



 

 

26 

6. Click the back arrow to the left of ‘Create rule’ and then +Add rule 

7. Follow the same steps to show text as a shade of red if the status is equal to rejected 

 

8. Click Save 

Create a View for Logged in Users 

So that users only see their requests, create a view that is filtered to Created By is equal 

to [Me] and set this as the default view. 

Set as default view: 
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And add the filter: 

 

Power Apps 

Introduction 

Technically, this section is entirely optional. For the ‘Training Request Status’ field, you 

could add ‘for admin use only’ in the Description and then use the SharePoint form that 

gets auto-created with the list. I am adding a Power Apps form on top so that I can hide 

that field at all to the end-user. You may end up wanting to capture several fields of 

data that the end-user doesn’t need to see. 

This is also where I point out that I am not, and likely never will be, a Power Apps pro. 

This is the most basic of instructions, with tons of room for upgrades. If you already 

know how to use Power Apps, save yourself some time, and skip this section. 
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Customize the New Form for the SharePoint List 

Pre-requisite: the SharePoint list needs to be in modern mode. If you don’t see Power 

Apps in the ribbon, you may need to go into the List Settings > Advanced Settings and 

set the List Experience to ‘New experience’ 

1. From your Training Request list, click on Power Apps and then Customize forms 

 

2. Let’s make the form wider: 

a. In top left corner, click on File > Settings 

b. Change Orientation to Landscape 
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c. In lower right corner, click Apply 

d. In top left corner, click the back arrow to return to the form 

3. In the Fields pane, hover over Training Request Status, click the 3 dots and click 

Remove 
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4. Click the ‘X’ in the top right corner of that pane to close it 

5. Drag the right edge of the form to meet the edge of the canvas  

6. IMPORTANT: In the right pane, change the Default mode from Edit to New (you 

could stop here, save and publish and have a functioning form, but I’m going to 

make some more edits) 
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7. Make the form 2 columns by changing the drop down in the right pane 

8. Grab the edge of the Title field to take up the whole first row 

 

9. Let’s make room for a header at the top of our form by grabbing the top of the form 

and pulling down a bit 
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10. In the ribbon, click on Insert > Icons > Rectangle 

11. Place the rectangle at the top at the desired height 

12. In the Insert ribbon, click on Label, click into the Label and add the name of the form. 

Use the editing ribbon under Home to style 
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13. Again, you can stop here, save, and publish because once this form is in SharePoint, 

the controls to Save and Cancel will be added automatically. If you would still like to 

add a submit button, keep going 

14. First, we will need to create some space for it at the bottom of the canvas.  

a. In the left pane, click on SharePointForm1, this will select the form so that you 

can drag the lower edge up a bit 

15. Under the Insert tab in the ribbon, click Button 

a. Drag the button down to the bottom of the canvas 

b. In the right pane, in the Text field, replace ‘Button’ with ‘Submit’ 

c. As desired, change the size, font, and padding. (changing border radius will give 

your button rounded edges) 

16. Now the button needs purpose: 

a. With the button selected, set the OnSelect action to 

SubmitForm(SharePointForm1) 
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17. Now it’s ready to save and publish: 

a. In the top left corner, click File and then Save 

b. Click Publish 

c. Return to your SharePoint list and click New to see the form 

Note: If you have published a form that you need to delete, you can delete the custom 

form while keeping the SharePoint list intact. Go to the List Settings > Form settings, 

select ‘Use the default SharePoint form’ and then click ‘Delete custom form.’ 

Power Automate 

Introduction 

Next, we will add an approval workflow that looks up the requester’s manager and 

routes their training request for approval. I am starting from a template that is close to 

what’s needed to save some time; you could start from scratch if you really wanted to. 

Note: if you do not want the requests to go to the requester’s manager, you could add 

another field to the SharePoint List – add a people field titled ‘Approver’. 

Create the Power Automate Flow 

1. From the SharePoint List, click on Automate > Power Automate > Create a flow 
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2. In the right pane, select Start approval when a new item is added 

 

3. If this is your first time using Power Automate, you’ll see a getting started dialog box, 

click OK 

4. At the bottom of the page, click Continue 
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5. You will notice that most of this flow is pre-populated, the first container ‘When a 

new item is created’ already shows the Site and List. So now we will make just a few 

adjustments.  
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6. Grab the Get my profile (V2) container and place it directly beneath the first 

container, the start of the flow should look like this now: 

 

7. Now that it is going to check for the submitter’s profile, we need to look up the 

manager.  

a. Click on the + sign directly under the ‘Get my profile (V2)’ container 

b. Select Add an action 

c. Type in ‘get manager’ and select Get manager (V2) from the Actions list 
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d. Click into the User (UPN) field and in the Dynamic content pane, select User 

Principal Name 

 

8. Next, we need to assign the approval task to the manager: 

a. In the Start an approval container, click into the Assigned To field 

i. If the Dynamic content pane does not appear, click on Add dynamic 

content directly under the Assigned to field 
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b. Choose Mail in the Get manager (V2) section 

 

9. Now, the only thing left to add is to write back to the SharePoint list the status after 

it has been approved or rejected: 

a. Expand the Condition container on the left 

b. In the If yes container on the left, click on Add an action directly beneath 

‘Inform item creator of approval’
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c. In the search box, type ‘update item’ and select the SharePoint Update item in 

the Actions list 

d. For Site Address, select the SharePoint site from the drop-down 

e. For List Name, select the list from the drop-down 

f. Click into the Id field and select ID from the Dynamic content pane 

g. Click into the Title field and in Dynamic content pane, scroll down to the When 

a new item is created and choose Title from that section 

 

h. In the Training Request Status Value, update Submitted to Approved 

10. Next, follow steps b-g for ‘If no’ changing the last value from Submitted to Rejected, 

the end of the flow should look like the following: 
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11. In the top right corner, click Save 

12. Next, click Test and select I’ll perform the trigger action 

13. Go back to your Training Request form and submit an entry 

14. Return to the Power Automate flow to watch the progress 

15. If no errors, this flow is active and ready. 

Microsoft 365 Learning Pathways 

Introduction 

Microsoft 365 Learning Pathways is a digital, customizable, learning app part that 

streams on-demand content to your end-users, without them having to leave your 

environment. 

Rather than recreate all of Microsoft’s guidance in this book, I am going to focus on the 

topics that I cannot find in their documentation. 
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It starts with four main categories: 

1. Get Started 

2. Scenarios 

3. Products 

4. Adoption Tools 

Those categories are broken down into subcategories, and new subcategories can be 

added. At the time of this writing, there is not a way to add more main categories. All 

new content will need to map to one of the existing four. For example, New Hire 

Orientation information could be added to Get Started. Organizational tools outside of 

M365 could be added to Products. Role-based training could be added to Scenarios. 

It allows tagging content at three learner levels: 

1. Beginner 

2. Intermediate 

3. Advanced 
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It also allows tagging content to different audiences: 

1. Admin  

2. Help desk 

3. Change manager 

4. Champions/Trainer 

5. Executive Assistant 

6. VIP 

7. End User 

8. Content Editor 

9. Content Manager 

10. Group Owner 

11. Site Sponsor 

12. All 

Currently, there is not a way to edit the list audiences. 

Prerequisites 

The person installing the solution will need to be a Global Admin, and the app catalogue 

will need to be set up. Learn more here: https://docs.microsoft.com/en-

us/office365/customlearning/custom_provision#prerequisites 

Add the Solution 

Navigate to the Provisioning SharePoint PNP site to install the solution: 

https://provisioning.sharepointpnp.com/details/3df8bd55-b872-4c9d-88e3-

6b2f05344239 

https://docs.microsoft.com/en-us/office365/customlearning/custom_provision#prerequisites
https://docs.microsoft.com/en-us/office365/customlearning/custom_provision#prerequisites
https://provisioning.sharepointpnp.com/details/3df8bd55-b872-4c9d-88e3-6b2f05344239
https://provisioning.sharepointpnp.com/details/3df8bd55-b872-4c9d-88e3-6b2f05344239
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Once it’s ready, an email will be sent that has a link to the site and will need to set it up 

for first use. Learn more here: https://provisioning.sharepointpnp.com/details/3df8bd55-

b872-4c9d-88e3-6b2f05344239 

Customize the Solution 

Before making updates to the solution, get familiar with how it’s built and how users 

navigate through playlists.  

Microsoft’s instructions for customizations are here: https://docs.microsoft.com/en-

us/office365/customlearning/custom_overview. 

Content 

Hide Unwanted Content 

First, look at the default playlists and decide if anything should be hidden. If your 

organization doesn’t plan to use Yammer, you may want to hide ‘Connect your 

organization to Yammer’ in the Recommended subcategory and also hide the entire 

Yammer subcategory from Products. This can always be reversed if Yammer is later 

released to the organization. 

Add Missing Content 

Look at the existing M365 content and figure out if you have any assets you’d like to 

add to the existing products. Maybe you have document libraries or videos from internal 

trainings. For this example, we have a video in Stream that teaches end users about 

Planner and has a quiz embedded. 

To add this video and quiz: 

https://provisioning.sharepointpnp.com/details/3df8bd55-b872-4c9d-88e3-6b2f05344239
https://provisioning.sharepointpnp.com/details/3df8bd55-b872-4c9d-88e3-6b2f05344239
https://docs.microsoft.com/en-us/office365/customlearning/custom_overview
https://docs.microsoft.com/en-us/office365/customlearning/custom_overview
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1. From the Learning Pathways admin center, click on Planner and then the + sign in 

the top right corner 

 

2. Enter a Title and Description 

3. Select Planner in Technology drop-down 
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4. Set Level and Audience 

5. Scroll back up and click Save Detail to enable adding assets 

6. Click on +New Asset. This will allow you to create a new SharePoint page or point to 

an existing SharePoint Page 

7. Add the Title 

8. Assign Planner as the Technology 

9. Click Create Asset Page and then Open Page 

 

10. Edit the page and add the Stream app part 

11. For Source, select Single Video 

12. You will need to open another browser tab to navigate to that video in Stream to 

copy the URL 

13. Paste the URL into the Video address field 
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14. Close the left pane 

15. Optional: add text or other app parts to the page 

16. Publish the page and go back to the Learning Pathways admin center 

17. Click Save Asset 

18. Click on Close Playlist 

Next, focus on adding missing subcategories to the four main categories. Take the time 

to map out… 

Category > Sub-Category > Playlist/Level/Audience  

…before making any changes.  



 

 

48 

Carefully Consider Subcategories 

In the example created for this book, I added five sub-categories to the Products 

category: 

1. Power Platform 

2. Power Apps 

3. Dynamics 365 

4. PowerBI 

5. RPA 

Number one looks redundant to the other four as they are all considered part of the 

Power Platform, but I wanted a way to tag individual content and a way to roll it up into 

one sub-category when adding to SharePoint pages, more on that soon in Putting it All 

Together. 

 

Get Help 

The Learning Pathways Admin Success Center contains links to help with planning, 

customization, and adoption. You’ll find the link to it under the ‘Home’ menu. Find the 

link to learn more in the Appendix. 
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Putting it all Together 

Learning & development Portal on SharePoint Online 

 

Introduction 

As stated earlier, this example is based on an organization using a separate SharePoint 

Communications than the one that was created with the Learning Pathways solution. I 

did this for a couple of reasons: 

1. The Learning Pathways site has helpful links exposed that are important to the 

L&D admins, and I do not want to hide those 

2. Many organizations have already started a SharePoint, somewhere, for L&D 

purposes and this will prevent them from having to start over and migrate 

existing content. 

Add Learning Pathways App Part 

The first step is making the Learning Pathways app part available on your site.  
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1. From wherever you like to add new apps (landing page > New, settings cog > 

add an app, Site Contents > New), click to add an app 

2. In the left-hand navigation, click on From Your Organization 

3. Click on Microsoft 365 learning pathways. This will take a few minutes to 

become available. 

Add Entire App Part 

Create a new page and add the learning pathways app part so users can quickly see all 

playlists available to them. If there are too many playlists with restricted content, then 

skip this step and create pages with filtered app parts. 

Add Filtered App Part 

Next, to add a page that is specific to a category or subcategory, like the Power Platform 

or any role-based or scenario-based playlists you created, create a page, add the app 

part and then edit the app part. Filter as appropriate. 

Other Integrations 

Yammer 

On the landing page or on the page that has the entire learning pathways app part, add 

your M365 Champions Yammer Community. 
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The benefit of adding the Community to the page that holds all the playlists is that the 

feed stays visible as users navigate through all the products. 

Note: when adding this app part, search for Conversations, not Yammer. 

 

Leave the Conversation source set to Community and then click into the Search for a 

source field, all communities you can add will appear 
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Other Integrations 

Pages can be added without adding to the Learning Pathways solution if desired. You 

have an entire SharePoint Site at your disposal. Create as many pages as you need and 

on each of those pages, you have the option to add Quizzes, Stream Channels and 

single videos, countdown timers, call to action buttons, training calendars, quick links 

and more. 

Be sure to create a page for the Training Requests, with the request list set to the 

filtered view, and add it to the navigation. 

I also added a ‘Call to Action’ app part that allows you to quickly add text and a link to 

the web page for an attention grabbing button to submit new requests. 
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If you are new to editing modern SharePoint pages, check out the links in the appendix. 

Department Workspace on Microsoft Teams 

Introduction 

As so many of us live in Microsoft Teams throughout our workday, I want to show how 

to incorporate learning tools here to increase adoption. 

Create a Training Channel 

1. In your department’s Team, add a Channel dedicated to Training. 

2. Pin the Learning & Development SharePoint site as a tab Hint: you will need to 

use the Website tab for this, not the SharePoint tab 

 

3. The top navigation from SharePoint does not appear in Teams. Add a Quick 

Links app part to the L&D landing page to help user navigate. 
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4. On the SharePoint Site that is associated with your Team, create a Training page 

that is specific to the roles in your department. 

a. Add a Stream web part that is connected to your department’s Stream 

Channel. Alternatively, you could add Stream as a tab directly in Teams, 

but pinning this page instead allows for more flexibility. You could also 

add a document library, text, and links to the same page rather than using 

multiple tabs to present the same information. 
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5. Add the Yammer community as a tab (note: search for ‘Communities’ to add) 

 

Other apps to consider: 

• Pin quizzes directly into the Training channel 

• Install Quizlet (3rd party app) as a tab 
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• Add Planner to help everyone stay on top of required trainings and get 

automated reminders 

o With the charts view, gamify the completion of tasks 

Closing 

This is just the very beginning of what can be done in Microsoft 365 as a Learning & 

Development platform. The time invested in this ‘choose your adventure’ style of 

creation will be quickly offset by the savings in licensing and identity management, the 

increased adoption, and the integrated apps and automation. 

With Microsoft 365, your organization retains ownership of all data and can apply 

retention policies to ensure the data sticks around exactly as long as it should. 

Be sure to check out the linked articles in the Appendix to get more ideas and guidance. 
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Appendix 

Links for next steps: 

• Editing in modern SharePoint Online: https://support.office.com/en-

us/article/create-and-use-modern-pages-on-a-sharepoint-site-b3d46deb-27a6-

4b1e-87b8-

df851e503dec#:~:text=To%20make%20changes%20to%20your,your%20changes,

%20click%20Republish. 

• How to build a Registration or Sign-Up Solution in SharePoint: 

https://collab365.community/building-a-registration-sign-up-solution-in-

sharepoint/ 

• Power Apps Best Practices: https://jobs.collab365.community/powerapps-best-

practices// 

• How to do Conditional Formatting in Power Apps: 

https://collab365.community/conditional-formatting-powerapps/ 

• Get Started with Power Automate: https://docs.microsoft.com/en-

us/learn/modules/get-started-flows/ 

• Get Started with Power Apps: https://docs.microsoft.com/en-

us/learn/modules/get-started-with-powerapps/ 

• How to Build a Simple Dashboard: https://docs.microsoft.com/en-

us/learn/modules/build-simple-dashboard/ 

• Live Events in Stream: https://docs.microsoft.com/en-us/stream/live-event-

overview 

• How to organize Groups and Channels in Stream: https://docs.microsoft.com/en-

us/stream/groups-channels-organization 

• Live Events in Yammer: https://support.microsoft.com/en-us/office/organize-a-

live-event-in-yammer-105dd7af-9caf-4a5e-8a44-56d203e96551 

• Learning Pathways Success Center: https://docs.microsoft.com/en-

us/office365/customlearning/custom_successcenter 

• Data Management in Office 365: https://www.microsoft.com/en-us/trust-

center/privacy/data-management 

• Retention Policies in SharePoint: https://docs.microsoft.com/en-us/microsoft-

365/compliance/retention-policies-sharepoint?view=o365-worldwide 

• Records Management in Microsoft 365: https://docs.microsoft.com/en-

us/microsoft-365/compliance/records-management?view=o365-worldwide 

https://support.office.com/en-us/article/create-and-use-modern-pages-on-a-sharepoint-site-b3d46deb-27a6-4b1e-87b8-df851e503dec#:~:text=To%20make%20changes%20to%20your,your%20changes,%20click%20Republish.
https://support.office.com/en-us/article/create-and-use-modern-pages-on-a-sharepoint-site-b3d46deb-27a6-4b1e-87b8-df851e503dec#:~:text=To%20make%20changes%20to%20your,your%20changes,%20click%20Republish.
https://support.office.com/en-us/article/create-and-use-modern-pages-on-a-sharepoint-site-b3d46deb-27a6-4b1e-87b8-df851e503dec#:~:text=To%20make%20changes%20to%20your,your%20changes,%20click%20Republish.
https://support.office.com/en-us/article/create-and-use-modern-pages-on-a-sharepoint-site-b3d46deb-27a6-4b1e-87b8-df851e503dec#:~:text=To%20make%20changes%20to%20your,your%20changes,%20click%20Republish.
https://support.office.com/en-us/article/create-and-use-modern-pages-on-a-sharepoint-site-b3d46deb-27a6-4b1e-87b8-df851e503dec#:~:text=To%20make%20changes%20to%20your,your%20changes,%20click%20Republish.
https://collab365.community/building-a-registration-sign-up-solution-in-sharepoint/
https://collab365.community/building-a-registration-sign-up-solution-in-sharepoint/
https://jobs.collab365.community/powerapps-best-practices/
https://jobs.collab365.community/powerapps-best-practices/
https://collab365.community/conditional-formatting-powerapps/
https://docs.microsoft.com/en-us/learn/modules/get-started-flows/
https://docs.microsoft.com/en-us/learn/modules/get-started-flows/
https://docs.microsoft.com/en-us/learn/modules/get-started-with-powerapps/
https://docs.microsoft.com/en-us/learn/modules/get-started-with-powerapps/
https://docs.microsoft.com/en-us/learn/modules/build-simple-dashboard/
https://docs.microsoft.com/en-us/learn/modules/build-simple-dashboard/
https://docs.microsoft.com/en-us/stream/live-event-overview
https://docs.microsoft.com/en-us/stream/live-event-overview
https://docs.microsoft.com/en-us/stream/groups-channels-organization
https://docs.microsoft.com/en-us/stream/groups-channels-organization
https://support.microsoft.com/en-us/office/organize-a-live-event-in-yammer-105dd7af-9caf-4a5e-8a44-56d203e96551
https://support.microsoft.com/en-us/office/organize-a-live-event-in-yammer-105dd7af-9caf-4a5e-8a44-56d203e96551
https://docs.microsoft.com/en-us/office365/customlearning/custom_successcenter
https://docs.microsoft.com/en-us/office365/customlearning/custom_successcenter
https://www.microsoft.com/en-us/trust-center/privacy/data-management
https://www.microsoft.com/en-us/trust-center/privacy/data-management
https://docs.microsoft.com/en-us/microsoft-365/compliance/retention-policies-sharepoint?view=o365-worldwide
https://docs.microsoft.com/en-us/microsoft-365/compliance/retention-policies-sharepoint?view=o365-worldwide
https://docs.microsoft.com/en-us/microsoft-365/compliance/records-management?view=o365-worldwide
https://docs.microsoft.com/en-us/microsoft-365/compliance/records-management?view=o365-worldwide


 

 

58 

 

 

 

 

 

 

 

Meet the Presenter 

Kelly Edinger 

 
Passionate about helping organizations make the most of 

their technology investments by putting people and 

process first - communicate, empower, govern. I'm an 

experienced business and technical consultant and 

Microsoft Certified Trainer with a demonstrated history in 

software deployments and integration, creating strategies 

for user experience, business readiness, training, and 

governance. I also create and present industry webinars 

and blogs focusing on Office 365 and end user adoption. 

Modern workplace Business process improvement & 

automation Adoption & change management MCT | 

Customer Immersion Experience (CIE) Facilitator | 

Productivity Coach 


